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SUMMARY

1.

o~

How to measure association between ordinal variables: Pearson,
Spearman or Polychoric?

The Polychoric correlation: theoretical background
Where can we get Polychoric correlations: The R polycor package
How about PASW? The PASW Statistics R integration package

Getting the polycor into PASW Statistics menus: The PASW
Custom Dialog Builder
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1.

How to measure association between ordinal variables:

Pearson, Spearman or Polychoric”



Ordinal variables

are quite frequent in the social, biomedical and engineering sciences:

« Likert scales, e.g. Agreement with social policies: [Completely Disagree; Disagree a
little; Neither Agree or Disagree; Agree; Completely agree]

« Pain severity [It hurts a lot; It hurts; It hurts a little; Doesn’t hurt]
« Concrete cracking [No cracks; a very few cracks; some cracks; lots of cracks]
« Mineral Hardiness [1 — Talc; 2 — Gypsum, 3 — Calcite; ... ;10 — Diamond]

Ordinal variables (following Stevens, 1946):

* Reflect qualitative appreciations

 Have ordering properties

« But quantification of categories do not make sense

* Numbers, generally, assigned to categories only reflect ranks and not quantities



How do we measure correlations between ordinal variables?

1. Pearson Product-moment correlation: frequently used when categories are coded
numerically with a ranking nature and linear relationship assumed:
n

>, - X, —Y)

N i—1 _ Cou(X,Y)
n n S
SO, = XSO - V) o
=1 =1
Controversial:

— Requires calculations of Means and SD

— Quite frequent in Psychometrics. Stevens criticized its use in this field:
“As a matter of fact, most of the scales used widely and effectively by
psychologists are ordinal scales. In the strictest propriety the ordinary statistics
involving means and standard deviations ought not to be used with these scales,

for these statistics itmply a knowledge of something more than the relative rank
order of data’ (Stevens, 1946, p. 679).

— ‘Tolerated’” when the number of categories are large (5, 7 or even 10)



2. Spearman Correlation: Proposed by British psychologist Charles Spearman.

Assesses how well an arbitrary monotonic function (ranking) could describe the
relationship between variables, without making any assumptions about the nature of

the relationship: n
6> (Ry — Ry )
=1

n(n? —1)

Ifno tied ranks: Rg =1 —

SRy, — By)(By, — Ry)

If tied ranks: Ry = = =
Sy — RS (Ry — Ry
=1 =1

* |t’s just Pearson correlation on ranks.

» Frequently used for Descriptive Statistics

« But not for multivariate correlacional technigues like Factor Analysis (which, by the
way, was first proposed by Spearman, 1904).



3. Polychoric correlation

Psychometricians theorize that most psychometric tests produce interval scale
measures of cognitive abilities.

Thus, ordinal items in psychometric scales are just a ‘practical’ operationalization of
real continuous (latent) variables which can only be assed by means of ordinal scaled

(manifest) categories.

To assess the ‘true’ construct and their associations, we should estimate the correlation
between the latent continuous variables operationalized by the ordinal items

Polychoric correlations does that. Early work done by Pearson, who acknowledge the
facility of measuring variables in ordered categories

[Polyserial: one variable ordinal and one variable quantitative]
[Tethracoric: same as polychoric but for dichotomous variables]



Which correlation coefficient should one use?

Babakus, Ferguson, & Joreskog (1987) in the context of Confirmatory Factor Analysis:

“The polychoric correlation [as compared to Product-moment, Spearman's
rho, and Kendall's tau] procedure was found to provide the most accurate
estimates of pairwise correlations and factor loadings®
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2.

The Polychoric Correlation:

Theoretical Background



What is a Polychoric correlation?

Estimate of the association between two latent normally distributed continuous latent
variables, from which the two ordinal observed variables are manifestations.

Example:

Association between

‘X, - Satisfaction with service’ (from ‘1- Very dissatisfied’ to ‘56 — Completely satisfied’)
and

‘X,-Recommend service to a friend’ (from ‘1- Definitively not’ to ‘5- Definitively yes’)

| ets assume:

1. ‘Satisfaction’ is a (approximately) normally distributed latent continuous variable, for
which X, is a categorical ordered operationalization

2. ‘Recommendation’ is (approximately) normally distributed latent continuous variable, for
which X, is a categorical ordered operationalization



operationalized as:
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'5 — Definitively yes' if & > &,



Combining the two variables:
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How do we estimate Polychoric correlations?

0. Polychoric mathematical series decomposition (not in use anymore)

1. Maximum Likelihood:

a. Estimate combined probability for observations z,,and x,, from standard normally
distributed ¢, and &, as

fu 521' —1 2 _ ¢ 2
1 9 <€1 2,05152—1‘52
Pz‘j — f f Cb(fpfz;p)dfzdfl where ¢(£17€23p) - 5 x e 20=r)
i1 i1 27 (1 - P )
is the standard normal bivariate density of ¢; and &,
b. Obtain Maximum likelihood estimate of pp.
r S
L = kH H P;if where n;;— number of observations of z,; € x,;
=17=1 r,s — number of ordered categories of £ and &,.
Differentiate the Ln (L) with respect to all model parameters (p, €11, - &1 o1y -+ 5 So0)s

equate to zero the resulting partial derivatives, and solve this equation system.



1. Maximum Likelihood:
b. Obtain Maximum likelihood estimate of pp¢

for example, the partial derivative of p is

aLn

EZ Dy [ 51@'752]'3/)) — Qb(gli_pgzj;p)]_ ¢(£1i7€2j_1§p) + ¢(€1i—17£2j;p)

zlylzg

c. Solve iteratively using the L information matrix ... Computationally demanding!

2. Two-step algorithm
a. Fit univariate standard normal distributions to the marginal distributions of X; and X,
separately and estimate thresholds
b. Solve the Ln(L) for p only



PASW Statistics s/

4.

Where can we calculate polychoric correlations:

The R polycor package

15



Where can we get Polychoric correlations?

Commercial software:
* PRELIS/ LISREL
« STATA 8 (Polychoric program by Stas Kolenikov )
« SAS (Polychoric Macro from SAS)

Open Source software
* R (Polycor package by John Fox)

16



The R polycor package

‘Polychoric and Polyserials correlations package’ by John Fox (fox@mcmaster.ca)

Freely available at CRAN’s R repositories

Computes polychoric and polyserial correlations by quick “two-step” methods or ML,
optionally with standard errors.

Three programs:

» HetCor : Computes a heterogeneous correlation matrix, consisting of Pearson product-
moment correlations between numeric variables, polyserial correlations between numeric
and ordinal variables, and polychoric correlations between ordinal variables.

» Polychor : Computes the polychoric correlation (and its standard error) between two
ordinal variables or from their contingency table.

Polyserial: Computes the polyserial correlation (and its standard error) between a
quantitative variable and an ordinal variables.



A. Install Polycor package in R

» Select CRAN mirror

es | Windows Help

R version 2.8.1
| Copyright (C) 20
ISBN 3-900051-07

Load package...

Set CRAN mirror..,

Select ;epositoria... %
Install package(s)...
Update packages...

Install package(s) from local zip files...

Type 'demo()' for some demos,
'help.start()' for an HTML browser interface$
Type 'q()' to quit R.

" R is free software and comes with ABSOLUTELYS
You are welcome to redistribute it under cer$
Type 'license()' or 'licence()' for distribu$

R is a collaborative project with many contr$
Type 'contributors()' for more information a$
'citation()' on how to cite R or R packages §

'help()' for of

Singapore 2
Slovakia

South Africa

Spain (Madrid)
Sweden
Switzerland
Taiwan (Taichung)
Taiwan (Taipeh)
Thailand

USA (AZ) g

USA (CAT)
USA (CAZ)
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A.

Install Polycor package in R

» Install packages...

» Select ‘polycor’

p[ ok |

File Edit View Misc [Packages| Windows Help

: Load package...
Set CRAN mirror..,
Select repositories...

Install package(s)...

R version 2.8.1
Copyright (C) 20( Update packages...
. ISBN 3-900051-07

Install package(s) from local zip files...

R is free software and comes with ABSOLUTELY NC WARS
You are welcome to redistribute it under certain co$
Type 'license()' or 'licence()' for distribution de$

Type 'contributors()' for more information and

\
\
' R is a collaborative project with many contributors.
' 'citation()' on how to cite R or R packages in publ$

Type 'demo()' for some demos, 'help()' for on-line §
'help.start()' for an HTML browser interface to hel$
Type 'q()' to quit R.

> |

plspm
plugdensity
plus

plyr

PMA

pmg

pmml
poileg
polLCA
polspline

Eo&agost
| polydect E

polynom
PolynomF
Pomic
pomp
popbio
popgen
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B. Run hetcor program

We will use an SPSS data file
named ‘DataAF.sav’:

5 Likert type items (X1,...,X5)
2 Scale variable (Age, SchoolYrs)
1 nominal variable (Sex)

20

e - -_—
E DataAF.zav [DataSetl] - PASW Statistics Data Editor

(=] @ o

File Edit View Data Transform Analyze DirectMarketing Graphs Utilities Add-ons

Window Help

=1 = Y EAT N ER BeEd0% W

11:x1 2

\Visible: 7 of 7 Variables

lox oxe [ ox [ @ | x5 | Age | s« |
1 | 9 2 3 2 3 18 Male [<
2 3 2 3 1 2 19 Male
3 1 2 1 1 1 20 Male
4 3 3 3 3 3 21 Male
5 2 2 3 3 3 19 Male
[ & ] 1 2 2 2 2 20 Male
2 3 1 2 2 21 Female
3 2 3 3 3 22 Male
9 1 1 3 3 2 23 Female
10 3 3 2 2 2 21 Male {
11 2 2 3 3 3 20 Female
12 1 1 2 1 1 18 Male
13 1 2 1 1 3 24 Female
14 3 3 3 3 3 27 Male
3 3 2 2 2 23 Male
2 2 1 2 3 25 Male
17 1 1 3 2 3 27 Male
18 3 3 2 3 3 29 Female
19 2 2 3 3 2 30 Female | |
=
— . B 2 p p . 2 reeere
——

|F'ﬁSWStati3tics Processoris ready| | | |




To import PASW (*.sav) data to R one can either:
Within PASW: Export data file to “*.Dat’ format and read it from within R

1.

> Data<-read.table("D:/ASSESS/DataAF.dat", header=TRUE)
Use library(foreign) to import PASW files

> library (foreign)

> data<-read.spss("D:/ASSESS/DataAF.sav", to.data.frame = TRUE)

Make sure the data file was

imported ok:
> Data

21

rR RGui

e —

File Edit View Misc Packages Windows Help
EREREE
IR R Console N
Warning message:
In read.spss("D:/ASSESS/DataAF.sav", to.$
I D:/ASSESS/DatalAF.sav: Unrecognized rec$
> Data
X1 X2 X3 X4 X5 Age Sex
p ¥ 2 2 3 2 3 18 Male
2 3 2 3 1 2 19 Male
3 ¥r 2 ¥ ¥ ¥ 26 Male
2 3 3 3§ 8 3 2¢ Male
I 5 2 2 3 3 3 19 Male
13 T Z2 2 22 2 28 Male
7 2 3 1 2 2 21 Female
8 3 2 3 3 3 22 Male
8 1 1 3 3 2 23 Female
16 3 3 2 Z 2 2x Male
11 2 2 3 3 3 20 Female
12 1 1 2 1 1 18 Male
13 1 2 1 1 3 24 Female
| i1¢ 3 3 3 3 3 27 Male
18 3 3 2 2 2 23 Male
¢ 2 2 ¥ 2 3 25 Male
¥r X X 3 Z 3 27 Male
18 3 3 2 3 3 289 Female
19 2 2 3 3 2 30 Female
20 3 3 1 1 1 31 Female

|

m

IR D:\ASSESS\poly - R Editor

# Load required Libraries
library(foreign) $re
library (polycor) $re

# Import data from PASW
data<-read.spss ("D: /ASSESS/

113




1. Load Library polycor
> Library(polycor)
2. Assign correct measurement scale to variables (even if you already did it in PASW)
> Data$Xl<-ordered(Data[,l]) # convert var. to ordered factor
> Data$X2<-ordered(Data[,2])
()
> Data$X5<-ordered (Data[,5])
> Data$Age<-as.numeric(Data[,6])# convert var. to numeric
> Data$Sex<-factor(Data[,7]) # convert var. to nominal factor
> SchoolYrs<-as.numeric(Data[,8]

Notes:
in R “<-" is the same as “="

Data frames are matrix with rows and columns e.g. Data [2,1] is the element in the 2nd
row and first column; Data[ ,1]is the first column which can be evoked as
DataScolumnname



3. Calculate polychoric, polyserial or pearson correlation accordingly to var. measurment:

> R<-hetcor(Data, ML=FALSE, std.err=TRUE)

> print (R)

Notes:
Options are:
ML=TRUE (Default)
ML=FALSE (two-step algorithm)
std.err=TRUE (Default)
std.err=FALSE (does not show SE)
R is case sensitive:
‘Print’ is not the same as ‘print’

23

X2 0.9624
X3 0.1181 0.4176
4]

R Roui - —— - -
File Edit View Misc Packages Windows Help %
EEEREEE
R R Console
Correlations/Type of Correlation:
X1 X2 X3 X4 X5
X1 1 Polychoric Polychoric Polychoric Polychoric
X2 0.9149 1 Polychoric Polychoric Polychoric
X3 0.3046 -0.04534 1 Polychoric Polychoric
X4 0.5117 0.3392 0.793 1 Polychoric
M X5 0.3154 0.2072 0.59892 0.757 p
Age 0.2962 0.3338 -0.1196 0.2425 0.1078
Sex 0.1106 -0.0618 0.2814 -0.04057 0.3326
H Age Sex
X1 Polyserial Polychoric
X2 Polyserial Polychoric
X3 Polyserial Polychoric
X4 Polyserial Polychoric
X5 Polyserial Polychoric
Age 1 Polyserial
Sex -0.4383 1
l Standard Errors:
X1 X2 X3 X4 X5 Age
X1
X2 0.04914
X3 0.2347 0.2537
X4 0.2083 0.2264 0.1129
X5 0.2403 0.2452 0.1859%9 0.13
' Age 0.2087 0.2044 0.2329 0.2162 0.2283
Sex 0.2841 0.2817 0.2759 0.2821 0.2593 0.2108
n:= 25
P-values for Tests of Bivariate Normality:
X1 X2 X3 X4 X5 Age
X1

4 L
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4. Calculate any other correlations

> RX1X2<-hetcor(Data$Xl,Datas$X2, ML=FALSE) #Correlation between
#X1 and X2

> print(RX1X2)
5. Extract only a fraction of the R object (hetcor produces a List)

> str(R) #see structure of R object
> print(RScorrelations) #only prints the correlation matrix
' ' R rew - =
0. Print scatter matrix of data N T— —
> pairs(Data)
R ® Comale
P-values for Tests of Bivariate Normalicy:
X1 X2 X3 X4 X5 Age
| x
X2 0.9624
X3 0.1181 0,4176 te 1 2 "N
X4 0.1726 0.904% 0.7126 LdL Lol

A5 0.2314 0,3836 0.1642 0.1551

3 " O B 1 " . A
hge 0.784¢ 0.1764 0.9528 0,9843 0,7949

Sex 0.4973 0.5174 0.3888 0.4243 0,3269 0.9275 e r= = . —
> print (RScorrelations) 72; _ . QR B A . .::’
X1 x3 1l .

X1 1.0000000 0.91486853% ©,304¢4611 90.51174() % = . -

X2 0.91¢8685 1.00000000 -0,04534338 0,33921" v & o

X3 0.3046461 -0.04534333 1,00000000 O.79298! o B LT N AL ¢ Npmre
| X4 0.5117408 0.33921712 0.792983%6 1,00000( —

XS 0.3194322 0.20718013 0.58817842 0.787041 " i - - -

Age 0.2961867 0.33384888 -0,11888788 D,24254 " 4 L 1| = o poane

Sex 0.1108811 -0.06180022 0,28144383 -0, 05086! o - a Al boea

Age Sex - .- - -
X1 0.2961867 0,110581407 [ " ] [ . } b o+ o F " " -
Xz 0.3338439 -0.08180022 - -
4 5 -.

X3 -0.1195373 0.28154383 R 4% -

X4  0.2425481 -0.04056940 3 1! I . E 2 o
Xs  0.1077330 0.3325723% - & | i N ]

Age 1.0000000 -0.4383333€ v - - v — o
Sex -0.43233%4% 1.00000000

> N N N N . -
X - -

12 12
T
P

»

:
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Too much typing?
... only the first time if one saves a script *.R file ...
» File » Save (CTRL+S)

TR D:\ASSESS\poly.R - R Editor =N =R

# Load regquired Libraries -
library(foreign) #required to import PASW .sav files i
library (polvycor) $required for the polychoric correlation

# Import data from PASW
Data<-read.spss ("D:/AS5E55/DatalkF.2av", to.data.frame = TRUE)

# Aszign correct measurment levels to variables

Datas$¥l<-ordered(Data[,1]) $# convert variable to ordered factor
Dataf¥2<-ordered (Data[,2])

Data$X3<-ordered (Datal[,3])

Datai¥4<-ordered (Datal[,4])

Dataf¥5S<-ordered (Datal[,5])

m

DataShge<—as.numeric (Datal,6]1) # convert wvariable to numeric
DataiSchool¥rs<-az.numeric (Datal[,7])
DatafSex<—-factor (Datal,8]) # convert wvariable to nominal factor

#Calculate=s Heterelogous correlations
R<-hetcor (Data, ML=FALSE, std.err=TRUE) #Estimates with ML; if ML=FALSE,estin

print (R) #Note: R i=s case sensitive: 'Print’ i
RX1¥2<-hetcor (Datas¥l, DatasX2, ML=FALSE) #Correlation between X1 and X2
str (R) #see structure of R object T
print (REcorrelations) #only prints the correlation matrix

4 | 1 | 3




PASW Statistics v

t @

0.

How about PASW Statistics?

The PASW Statistics - R Integration
package



How about PASW Statistics?

There is no poychoric or polyserial correlations in PASW Statistics (up to v18).

However, SPSS v16 or higher allows one to include R code into SPSS Syntax.

PASW18 (just released) has an ‘R Essentials’ package:
« PASW :R integration plug-in
« R2.8.1
» Several examples of R libraries portrayed to PASW Statistics 18

The PASW-R integration plug-in and its R package provides functions for:

1.

A S A

Read case data from the active dataset into R
Get variable information in the active dataset
Get output results (via OMS) from PASW into R
Write R results back to PASW output viewer
Display R graphics in the PASW output viewer
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» Browse to http://www.spss.com/devcentral/
» Register a free account
» Navigate to ‘R Essentials‘ (bottom of the page)

» Download R essentials for Windows32 or Windows64 (if other OS, see below)
» (accept the legal disclaimers) Install R essentials

= =— —

S ¥ Google oo )bl
= Welcome to SPSS Develo... * \ 22| b
€ 9 C M % hitp//www.spss.com/devcentral/ > B O £~
Find great articles and other documentation at SPSS Developer Central. SB35 . ‘ g
S— = )eveloner Rlao . = — — T—
= Soogle =Y C
Articles . KGN |y oL}
- /B Welcome to SPSS Develo... * \ &2\
Programmability in SPSS Writing SPSS Extension —_ ]
Statistics 17 Commands € 2 | C A % hitp//www.spss.com/devcentral/index.cfm?pg=rresources » B~ O~ &£~
Review of programmability Explains how to create SPSS )_—S—PS—S*I ie\/él O p e F C e n t r a l -
features and a set of examples Extension Commands
Downloads
Installing Tools for Working with R in PASW Statistics Developer 18 and PASW Statistics 18 > !]
PASW Statistics R Essentials includes all of the tools you need to fully utilize PASW Statistics Download code
Developer. It includes the R application, the R Plug-in, and a set of fully functional R examples. :n"g :m;;g‘“mse?s
Developer Central Announcements You can also use it with PASW Statistics version 18 or later. community. e
3 / =t
Plugins Download Page Programming and| Download R Essentials: Windows32 | Windows64 : |
Statistics 18 @ SPSS Developer Forums ‘
Look here to find the right plug-ins for your version On non-Windows platforms, the tools included with R Essentials are distributed in up to three ‘
of SPSS or SPSS Statistics. The excellent Dat3 downloads. As a rule, install the R application first, followed by the R Plug-in, and then followed Share code, solve problems, and be =
free from SPSS Inc, by the R Examples. For platforms other than Mac you will need to obtain R 2.8 from more productive - access SPSS l
ta l?ASW Statistic hittp://vwveve.r-proiect.org. Details are provided in the installation instructions included with the R | DEVeioper Forums now.
edition: Plug-in for the associated platform. + DevCentral Forums [
R Essentials » SPSS Programmability
Operating System Tools » Advanced Visualization
Download the tools you need for using R in PASW Mac R Plugin | R Examples
SMatstcs 18 Linux 32 R Plugin | R Examples
Investor Relations | Worldwide Offices | AIX 64 Server R Plugin | R Examples [Great Linka
HPUX 64 Server R Plugin | R Examples SPSS Blogs
ttp:// SpsecomideveentralfindescFipg—s Linux 64 Server R Plugin | R Examples = SPSS Developer Blog

Solaris 64 Server R Plugin | R Examples = Developer Video Blog



http://www.spss.com/devcentral/

R essentials

R essentials will install:

R 2.8.1 application (R is actually in version 2.9.2, but for compatibility proposes its better to

keep 2.8.1)
PASW Statistics R Plug-in

PASW Statistics R examples with CDB and syntax extensions

=
ﬂ PASW Statistics 18 R Essentials - InstaliShield Wizard

Statistics 18 R Essentials

' The InstaliShield(R) Wizard will allow you to modify, repair
remove PASW Statistics 18 R Essentials. To continue, dicl
Next.

Welcome to the InstallShield Wizard for PASW i
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1) PASW Statistics 18 R Essentials - InstallShield Wizar

InstallShield Wizard Completed

| The InstaliShield Wizard has successfully installed PASW
Statistics 18 R Essentials. Click Finish to exit the wizard.




R code into PASW Statistics

In PASW Statistics:
» File » New » Syntax

» R code must be enclosed in between (syntax block)
BEGIN PROGRAM R.

()

END PROGRAM. */ don’t forget these “.”

v s 7o oo e

Now

Open

|  OpenDatapase

T Read Ted Data

mon

L]
Save As.

By Save AR Data

= Export 10 Database.

)IOQFIIORMOMI

W Rename Dataset.
Display Data Fils Information

[53 Cache Data

o

O Swich Server_
Repasitoery

A Pt Predes

S et
Recontly Used Oata
Recentty Used Files
Ent

’
»
»

& pats

= pntax

B owon
I8 sgnp i

o] FEL "Syntaxt - PASW Statistcs Syntax Edito i
Y .- File Edit View Data Transform Analyze DirectMarketing Graphs Utilities Add-ons Run Tools Window Help

30

BHD B ™ BELT R PO 20 & B H u

e

| Syntax

W N W N WD W W e DWW -y

NN W e WO W LN N W W -

 PASW Statsics P

|| 4 ® @ B B W Actve: [Datasett

| [ BEGIN PROGRAM |1
| lleno PrOGRAM. |2

2

) help.start ()

fﬁI:BEGm PROGRAM R.

END PROGRAM.

Line

Command Information

|PASW Statistics Processor is ready[ [ |In 1Col 16[ [




Can just paste the code we did before:

Blocks area

*Syntax polycor.sps - PASW Statistics Syntax Editor

File Edit View Data Transform Analyze DirectMarketing Graphs Utilities Add-ons Run Tools Window Help |

L ey e
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BAES Y BhE&SE A PO 0 & B | Q’A"I%
M @® & B B Il Adive: DataSet! ~ P sefction  cti+R
secinerncran [ |1 PYBEGIN PROGRAM R =1 ToEnd
END PROGRAM. 2 # Load required Libraries Step Through
3 library(foreign) #required to import P. =
4 library (polycor) #required for the poly @ Confinus  Shifi+Tab
5 Active DataSet
B # Import data from PASW
% Data<-read.spss("D:/ASSESS/DataAF sav", to.data frame = TRUE)
8
g # Assign correct measurment levels to variables

10 Data$X1<-ordered(Data[,1])
11 Data$X2<-ordered(Data[,2])
12 Data$X3<-ordered(Datal[,3])
113 || DataSX4<-ordered (Data[.4])
14 Data$X5<-ordered (Data[,5])

16 Data$SchoolYrs<-as.numeric(Data[,7])
17 Data$Sex<-factor(Datal,8])

19 #Calculates Heterelogous correlations

print(R)

# convert variable to ordered factor

15 Data$Age<-as.numeric(Data[,6]) # convert variable to numeric

# convert variable to nominal factor

20 R<-hetcor(Data, ML=FALSE, std.err=TRUE) #Estimates with ML; if ML=FALSE,
#Note: R is

:> code area

|PASW Statistics Processor is ready |

lIn1col 4]

Debug area



» Run » All

‘R output” will be parsed as a text block into ‘PASW output viewer’:

[ “Output3 [Document3] - PAS
File Edit View Data Transform Inset Format Analyze DirectMarketing Graphs Ulilities Add-ons Window Help

|EHDOR ¢ B v BELD @® & BB B
D + - BE BHa

{&] output

(8 Lo
@ . Two-Step Estimates

Correlations/Type of Correlation:

i X1 x2 X3 X4 X5 Age
X1 1 Polychoric Polychoric Polychoric Polychoric Polyserial Pol
X2 0.9244 1 Polychoric Polychoric Polychoric Polyserial Pol
X3 0.2349 -0.09612 1 Polychoric Polychoric Polyserial Pol
X4 0.5182 0.3558 0.7768 1 Polychoric Polyserial Pol
X5 0.2924 0.1827 0.5746 0.7173 1 Polyserial Pol
RAge 0.2214 0.2373 -0.01769 0.3285 0.1665 1 Pol
Sex -0.1061 0.02131 -0.1808 0.02353 -0.4265 0.2776

School¥rs -0.0929 0.02237 -0.1469 0.02698 -0.3563 0.2186

Standard Errors:
X1 X2 X3 X4 X5 Age Sex
X1
X2 0.0357
X3 0.2248 0.2349
X4 0.1772 0.1994 0.1037
X5 0.2203 0.2271 0.1727 0.1214
Rge 0.194 0.1939 0.2236 0.1812 0.2012
Sex 0.2553 0.257 0.268 0.2569 0.214 0.2171
SchoolYrs 0.2061 0.2081 0.2154 0.2085 0.1745 0.1738 Inf

=¥

n = 30

P-values for Tests of Bivariate Normality:
X1 X2 X3 X4 X5 Age Sex =

v |

PASW Statistics Processor is ready| | |H: 51.96, W: 24.58 cm

|Logis visible
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But, we should:
1. Get variables directly from PASW Statistics active data set
2. Route R output to PASW Statistics output tables

1. To get data from active PASW Statistics:
>Data<-spssdata.GetDataFromSPSS(variables="X1 X2 X3 X4 X5 Age Sex SchoolYrs")

# Reads the variables from SPSS active datasheet

To get variable information from active PASW Statistics:

>vardict<-spssdictionary.GetDictionaryFromSPSS(variables="X1 X2 X3 X4 X5 Age Sex
SchoolY¥rs") # Gets variables definition from
¥ PASW: It is fundamental that the
# right measurement scale is used

Missings in the Data”? Handle them in R:
>is.na(Data)<-is.na(Data)
>Data<-na.omit(Data)

Or, as per v.18:

>Data<-spssdata.GetDataFromSPSS(variables="X1 X2 X3 X4 X5 Age Sex SchoolYrs”,
missingValueToNA=TRUE)



Pass the variable’s information (measurement level) to R:
Loop for i=1 to length of Data frame

Check PASW measurement level

Convert vectors into numeric, ordered or factor R vectors accordingly to measurement level

for (1 in l:length(Data)) {

if (vardict["varMeasurementLevel",i]=="scale") Data[,i]<-Data[,i]
else

if (vardict["varMeasurementLevel",i]=="nominal") Data[,i]<-factor(Data[,i])
else

if (vardict["varMeasurementLevel",i]=="ordinal") Data[,i]<-ordered(Data[,1])

}

OR, for PASW18 or higher:
spssdata.GetDataFromSPSS(“x1 x2 x3", factorMode="labels”) Will get the correct factors
(nominal or ordinal into R with value labels)

spssdata.GetDataFromSPSS(“x1 x2 x3", factorMode="levels”) Will get the correct factors
(nominal or ordinal into R with values)



Do the calculations:
#Calculates Heterogeneous correlations

R<-hetcor(Data, ML=FALSE, std.err=TRUE)

2. Route R output to PASW Statistics output tables

Note: Complex R list objects (like the one created by hetcor) cannot be passed directly to
PASW Statistics output tables

One has to pass list elements one by one.
To see the structure of the object created in R and the names of its elements do:

>str(R)
For example, hetcor, produces a list with elements:
Scorrelations (correlation coeficients)
Stype (type of correlations)
Sstd.errors (std.errors)
Sn (sample size)
Stests (p-values for bivariate normality tests)



Write the correlation type table to PASW Statistics output table:
spsspivottable.Display(RStypes, title="Correlation types")

Write the correlations table to PASW Statistics output table:
spsspivottable.Display(RScorrelations, title="Correlation matrix")

Write the Std.Errors table to PASW Statistics output table:
spsspivottable.Display(R$std.errors, title="Std. errors")

Write the ‘n’ table to PASW Statistics output table:
spsspivottable.Display(R$n, title="n")

Write the ‘bivariate tests’ table to PASW Statistics output table:
spsspivottable.Display(RStests, title="Bivariate Normality tests")

More complex hierarchical tables can be produced with BasePivotTable()
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;__2 .Syntaxpolycorv_‘ - Stat S ‘i-' Pﬂ
File Edit View Data Transforn Analyze Direct Marketir Graphs Utilities Add-ons Run Tools Window Help
| = 2 T T
[ B r BELE B ro @0 [Fondtmes Ve, R«
Filn Wew Oata Transform Insert Format  Anabze DiroctMarkeling Graphs  UMities Add-ons  Window  Help
> 7 e : ; | - A |
e — Hea B x> BEhS 00 % Bap B & + -k &g |
END PROGRAM. 1 #Handle missing data B R ~ 3 Polchone Polychork Poivchosic FPonehonc Folserial Polythore Polys®i}|
12 is.na(Data)<-is.na(Data) gm. 4 Polethonc Pnrmmrft Potycheric Poychotic | Polyserial | Potechore | Polyd
13 Data<-na.omit(Data) # remov & Notes 5 Palpchoric | Pobecheric | Polychoric | Polyehoric Polserial | Polenore | Polyd
14 :2::::“‘“ 3 Polserial | Pohsedal | Polysanal | Polyseris | Poysersal Potserdal | Pesr
15 #Pass the variable information (measuremen b T Palthane Polychork: Polychorie | Polychorie | Polchone | Polysenial Pahyd
16 for (i in 1:lenglh(Data)) { = Palyserial Palysesrial Polysenal Polysenat Poysonal Faarson Polyseral
17 if (vardict["varMeasurementLevel",i]=="scalé
18 if (vardict["varMeasurementLevel",i]=="nor [ R
19 if (vardict["varMeasurementLevel".i]=="or|

} ]

| [DataSetl] D:\ASSESS\DataA?P.sav

#Calculates Heterelogous correlations
R<-hetcor(Data, ML=FALSE, std.err=TRUE)

i nd R output to PASW Statistics output t
26 spsspivottable Display(R$type, title="Correlat

27 ivottable Display(R$correlations, titl ‘fl
28 t

29
30
3
32 QEND PROGRAM. Schoofvrs

33
| R

[F’ASW Statistics Processor is ready

[DataSerl] D:\ASSESS\DataAF.sav




s it necessary to write a new program every time we want to
use polycor (or any other R library)?

NO!

Implement a Custom Dialog into PASW to:
1. Select variables through familiar PASW statistics menus
2. Produce PASW Statistics regular output

38



PASW Statistics

c @

O.

Getting the polycor into PASW menus:

The FASW Custom Dialog Builder



The Custom Dialog Builder

(PASW v17 or higher)

In PASW Statistics:
» Utilities
» Custom Dialogs
» Custom Dialog Builder

i

R e

RS B e w EAE N EE ESE | 8 vanates,
(11 l2 £ OMS Control Panel,. |visitée: 8 of & Variables
X3 | s | x| Ag | § EoMSientsers_ vor | owr |
L 3 2 3 1 | Data File Comments
2 3 1 2 19 ? Defirva Vanable Sets...
2 : : 4 o (@ Use Variable Sets
4 3 3 3 21 =
5 1 3 3 19 Q) Show &t Vanatiss
6 2 2 2 2 B Spelling
7 1 2 2 2 b Run Script
] 3 3 3 22 [ Production Job.
e . 3 - 2 1" custom Dialogs ,
— 3 = 2 = D [[&] instail Custom Qiatog..
e —— : Extension N\du » r g 1
1 3 3 3 2 e s 8 Custom Diaiop Qusder.
Bt 2 1 1 8 Mae 600 i
= 1 1 3 2 Female 700
" 3 3 3 ar Male 800
15 2 2 2 3 Male 1200
16 1 2 3 2% Male 1400
) 1 3 2 3 27 Male 15.00
Duta Vew Vatadle Viow,
[Custon Dialog Buider [PASW Stalistics Processof i ready !

I
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a1

Menu Layout canvas

AN

Tools. (e Custom Dialog Builder - (Untitled) =cE

N
Ny
ID Source List | File Edit View Window Help

‘ﬁTargetList AE % Q =7

Check Box

B’ Combo Box
B ListBox

[2] Text control
TOO‘s bO% -| [Z] Number control
Ab Static Text

[ Radio Group

\
|

[T tem Group ‘ ‘
\
‘
1 check Box Group |
\

= File Browser

% Sub-dialog Button

Dialog Properties |
. Property |Value |
Properties box Siaiog Name GalogT z

enu Location

(& code, location in ‘nu . _
PADW, Title, etc... |

eb Deployment Properties
odeless True -~




Fill in Dialog properties:

Dialog Name

Title

Menu Location: click &
Select: Analyze » Correlate
Click Claal

Syntax
(Leave it alone for now)

B2 “Custom Diatog Builder- Poly
File Edit View Window Help

26 % @ 27

)

Dialog Properties
Property | value
DialogName  Poly
Menu Location |
Title  Poly correlations
Help File |

Web Deploym...
Modeless True
Syntax =7
Required Add... one

] Custom Dialog Builder: Menu Location

Locatg

Menus:

B-Data

&-Transform

E-Analyze

El-Reports

&-Descriptive Statistics

& Tables

E-Compare Means
El-General Linear Model

<- Generalized Linear Models
B-Mixed Models

(_w |

| MoveUp |

Move Gown

~ Delete

El Cprrelatp\
'

Title: |Poly correlations

["] Display a separator: ‘i»l.sove

Image:

- |
‘

| | (growse..)
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Add Input Variables:

} SeleCt | D’SUUFCQ List | tOO| r *Custom Dialog Builder - dialogl ?E‘_@ S ,.‘
' File Edit View Window Help
» Drag the Source variables box — = = =
S HH % B 7T
into drawing canvas J Ll
. 9 . . jariables: B Filter ]
» Double-click to edit properties &, Vecislel ,
£l variable2 Type
T : : : Variable3 ;
» Fill in the ‘Source variables List Properties || [ Bloms :
iNumeric (excluding Date/Time}
%‘g_atemme
-Measurement Level
[+l Nominal
[/ Ordinal
[ Scale
~Special
["] Multiple Response Sets
;urm Variable List Properties —
Property Value
Identifier — item_ 37 ﬂ
Title : |Variables:
I -
Source Variable List Properties
Property Value
|dentifier InVariables
Title Input Variables:
ToolTip Select the variables to correlate
Mnemonic Key |
Variable Transfers Move Variables
Variable Filter (Select to edit...)




Add Variables to correlate:

» Select freetust | tog

» Drag the Target variables box
into drawing canvas

» Double-click to edit properties

» Fill in the ‘Source variables
List Properties

C === =
*Custom Dialog Builder - dialogﬁ

File Edit View Window Help
BH % 8 =7
Input Yariables: Variahles to correlate:
& variablet & Variable
ol variable2
&5 Variable3 2
Target Variable List Properties
Property IVaIue
Identifier Variables
Title Variables to correlate:
ToolTip Variables for the correlation calculations
Target listtype Multiple item list
Mnemonic Key [
Required for execution True
Variable Filter (Select to edit...)

Syntax %%ThisValue%%
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Add Analysis options:
*Method of estimation: ML or Two-step

3 SeleCt IEICheckEloxGroupI tool

» Drag into drawing canvas

» Fill in the ‘Source variables
List Properties

» Click ‘Radio Buttons’ and change
its properties by clicking on &

[ *Custom Dialeg Builder - Poly i“ -

File Edit View Window Help

AH 3% B 2T B

Input Variables: Variahles to correlate:

& variablet

ol variablez .
&b Variable3 H

% Variahle

- Estimation method
(3) Two-Step
() Max. Likelihood

Radio Button Group Properties

Property |value

|dentifier Method

Title Estimation method
ToolTip

Radio Buttons |tSelect to edit )
Syntax %%ThisValue%%

e
Radio Group Properties

=

Identifier |Name |Too|Tip |Mnemonic Key INested Gr... IDefault Syntax
TwoStep Two-Step Selecttwo-st.. T false true FALSE]
MaxLik Max. Likeliho... Second Max. .. M false faise  |TRUE KBYWO"d‘-S for & 51“’(31‘

L
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Get the previously done syntax into the CDB syntax window:
» Syntax » @
» Copy &Paste syntax into CDB syntax window

Syntax Template “— =53 i

' *Custom Dialog Builder - Poly

File Edit View Window Help | Enter your syntax template below. The syntax template is used to generate syntax for your dialog.
f = = = = = | ‘| Enter replaceable values using the corresponding control identg,er enclosed within "%%’ symbols.
BF %% B =7 -

For example, one line of a syntax template may contain:
IVARIABLES %%var_list%%

Ingut Va_”ab'eS: Va"ab"?s fo-complats: Tip: You can select from a list of all available control identifiers to insert by positioning
& varisblet & Variable ‘X the text caret where you would like to insert an identifier and then pressing the
ol variable2 1l <CTRL><SPACEBAR> keys together. “
& Verishle3 : & || [BEGIN PROGRAM R.
|

# Load required Libraries
library (polycor)

|

- Estimation method |
(3) Two-Step ' # Get variables from PASW Statistics Active dataset

I

Data<-spssdata. GetDataFromSPSS(variables="X1 X2 X3 X4 X5 Age Sex SchoolY

() Max. Likelihood

I # Get variables information from PASW Statistics Active dataset
Dialog Properties vardict<-spssdictionary GetDictionaryFromSPSS(variables="X1 X2 X3 X4 X5 Age S

Property [Value -
Dialog Name 'Poly #Handle missing data

Menu Location AnalyzeICorrelatelF’oly correlations is.na(Data)<-is.na(Data) : "

il Title P°|y correlations Data<-na.0mlt(Dala) # removes mlSSingS Listwise
Help File j
|||Web Deployment Pro...
Modeless True

Syntax [
Required Add-Ons None

E———

B
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Get the previously done syntax into the CDB syntax window:
» Correct syntax for CDB specifications:
» CTRL+SPACEBAR to see a list of available CDB created keywords
» Change (both in spps.GetData and spss.GetVariables)
M¥1 X2 X3 X4 X5 Sex Age SchoolYrs” to "%%Variables%%”

Enter your syntax femplate below The syntax template is used 1o generate syntax for your dialog Enfer your syntax femplate below The syntax template is used 1o generate syntax for your dialog

Enler reptaceatle vaiues using the coresponding control ssntifier enciosed within %% symbols Enler reptaceable vaiues using the corresponding control dentifier endosed within %% symbols
For example.one e of 3 symiax lemplate may contain For example. one Ine of 3 symiax lemplate may contain
NWARIASLES %%ar_list%% MARIASLES %%ar_list%
Tip. You can select from a fiat of ol avadable control identibers ko inser by positioning Tip. You can select from a fiat of all avadable control identibiers 1o insert by positioning
he bead Caret where you would Hike 10 ins e an dentfier and Men pressing he e bed caret where you would Hie 10 ins et an identifier and Men pressing he
<CTRL><SPACEBAR> keys together. | <CTRL><SPACEBAR> keys together.
GIN PROGRAM R Load required Libraries
| 0ad required Libranes libeary (potycor)
rary (polycor)
Get vanables from PASW Statistics Aclive dataset

5ef vanables from PASW Statisbcs Active dataset Data<-spssdata GetDataFromSPSS(variables="%%Variabiest%")
a<-spssdala GetDataFromSPSS({varables=| mw
Method

1# Get variables information from PASW Statistics Active dataset
vardict<-spssaictionary GetDitionaryFromSPSS(v

51 variables information from PASWY Statistic
rdkt<-spssdictonary GelDichionaryFromSPSS{vanables="X1 X2 X3 X4 X5 Age Sex

#Handle missng cata
Is na(Data)<-is.na{D:ata)
Data<-na omit{Data) # removes missings Ustfu

Pass the vanabie information (measurement level) to R
for (I in 1 Data




Get the previously done syntax into the CDB syntax window:
» In hetcor(Data,ML=FALSE, ) Change FALSE to %%Method%%

g E -

Enter your syntax template below. The syntax template is used to generate syntax for your dialog.

Enter replaceable values using the corresponding control identifier enclosed within %%’ symbols.

For example, one line of a syntax template may contain:
NNARIABLES %%var_list%%

Tip: You can select from a list of all available control identifiers to insert by positioning
X the text caret where you would like to insert an identifier and then pressing the
<CTRL=<SPACEBAR=> keys together.

#Pass the variable information (measurement level) to R
for (i in 1:length(Data)) {
if (vardict["varMeasurementLevel",ij=="scale") Data[ ij<-Datal[.i] else
if (vardict["varMeasurementLevel" i]=="nominal") Data[,i]<-factor(Datal,i]) else
if (vardict["varMeasurementLevel",ij=="ordinal") Data[.ij<-ordered(Datal.i])

i

#Calculates Heterelogous correlations
R<-hetcor(Data, ML={{ y/ariaples RUE)

#Estimates

Send R output to PA| “e"‘°‘1> ut tables
spsspivottable.Display(R$type. title="Correlation types")
spsspivottable.Display(R$correlations, title="Correlation matrix")

=" errors”) ket
I¥

» File » Save (if you haven’t done so...)

For — —
e P — — -

48

Enter your syntax template below. The syntax template is used to generate syntax for your dialog.

Enter replaceable values using the corresponding control identifier enclosed within %%’ symbols.

For example, one line of a syntax template may contain:
INARIABLES %%var_list%%

* Tip: You can select from a list of all available control idehﬁers to insert by positioning
X the text caret where you would like to insert an identifier and then pressing the
<CTRL=<SPACEBAR=> keys together.

#Pass the variable information (measurement level) to R
for (i in 1:length(Data)) {
if (vardict["varMeasurementLevel"ij=="scale") Data[ ij<-Datal[.i] else
if (vardict["varMeasurementLevel" i]=="nominal") Data[,i]<-factor(Datal,i]) else
if (vardict["varMeasurementLevel",ij=="ordinal") Data[.ij<-ordered(Datal.i])

i

#Calculates Heterelogous correlations
R<-hetcor(Data, ML=gANEGR0EERA std.err=TRUE)

#Estimates

Send R output to PASW Statistics output tables
spsspivottable.Display(R$type, title="Correlation types")
spsspivottable.Display(R$correlations, titie="Correlation matrix")

ivottable. Displavi(R$ itle="Std. errors"} bath
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Polycor menu implementation with CDB
(PASW v17 or higher)

ﬂ.Custom Dialog Buildgr_ |
. . T . File Edit View Window Help
Instgll the Dialog in PASW Statistics: i T EEEN
» File » Install N

Install the current dialog |
Input Yariahles. variables to correlate:

& variablet & Variable

Yariable2
& Variable3 b

Estimation method
(3) Two-Step
() Max. Likelihood

Dialog Name - Poly _ )
Menu Location ‘Analyze/Correlate/Poly correlations

Title ' Poly correlations

Help File |

Web Deployment Pro...

Modeless True i S
Syntax ' BEGIN PROGRAM R.\n# Load required Librari...
Required Add-Ons None

If everything is ok, you should
see this: Bl paswsatisis s | B N |
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Restart PASW statistics
» Analyze » Correlate » Poly correlations:

e DA . =
: ﬁa gnw gm pm m mm Mu spln Mow Help
AWME B e 2 EA  Repos ’ n‘Q. -
11X 2 Descriptve Stalistics ' [visathe: @ o  vVaniables e = — ,
I 2 - 2 (
T 1w | Twe Ve[ A | s | B oy consiatin 5 A -
2 Compars Means ’ 3 18 Male =]
3 Genaral Linsar Model » 2 19 Male Input Variables: Variables to correlate:
1 Generakzed Linear Models 1 20 Male %3 4 x1
3 Mzed Moosis ’ 3 2 e o x4 ol x2
2 Cometzre , mm'b j 4 x5 a & hge
; Begrsssion Y| evenate [ schoolYrs | S | sex
Loghnear 2 IS Heterogensous Conetsions._
3 Neurst Networes '@ |
1 Cizsslly ’ mn; |
3 DemensionRaduction o Estimation method——
2 Scate , | K4 Distances..
1 MonparameticTests  » 1 18 @iwoSien
1 Fodacaition g 3 24 © Max. Likelihood
3 % 3 27
3 g 2 2 = ) o) s
) s (Lok J[ paste || Reset ||cancel]
W 1 5 8eaing Vaiue Anatyeie 3 2 e — e
= Mtiple Imp ’ na
Comgiex Samples »
Qualgy Control ’
[ ROC Cunye.. hics Processcris readyl | | |
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and that is it:

Ot [E=EE
File Edit View Data Transform |Insert Format Analyze DirectMarketing Graphs Ulilities Add-ons Window Help
OHBR & N HEkH Q0 F AR H &5 + - BE Zde
= @ Output Lbatasetli)] LUI\ADDEDD\UATaar.sav =]

, ...... @ Log
B-ER p-values for Bivariate Normality tests
' 31 K2 X3 ¥4 X5 Age Sel
1 .0oo .0oo .0oo .0oo .00o .0oo
X2 960 .0oo .00o .00o .00o .00o
& 3 118 418 .ooo .0oa .0oo .0oo
I ] X4 A72 804 712 .0oo .00o .00o
....... Active Dataset X5 231 388 164 154 000 000
i ------- @ Correlation matrix| Age 782 A75 852 883 793 .00o0
B-ER Sex 437 517 389 424 327 927
(] Title
SchoolYrs .00e .036 .029 .00s 021 .024
[ Notes
' ~~~~~~~ Active Dataset
[ Std. errors
& = RGraph
' ’ [DataSetl] D:\ASSESS\DatalF.sav
|
: 10 20 30 10 20 30 18 4 RN 4 3 12
8 Notes iy s P e UL ' 3 pe
' ...... Active Dataset X1 o o b q o o o d o oo of p q |sooioer g
~~~~~~~ L& p-values for Bivari . a d alb d looma a
&+ {E] RGraph el
| itle 2 RN x2 P o d o dp o d fwow of b q | oo oo
‘ - Notes 24 2 o 2 @ o @ o i
i Active Dataset i " = i =
....... m RGraphic 3 4 e o X3 o o o q pwe of p qd poo oo
I ...... Log " " o " — ool 3
I
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If one wants to create custom output names enclose spsspivotable commands within
spsspkg.StartProcedure (“custom name”) ... spsspkg.EndProcedure()

spsspkg.StartProcedure ("Correlations")
spsspivottable.Display(RStype, title="Correlation types")

() -

W49

-~y —

spsspkg.EndProcedure () [E_Em yex Oa_Jonsom _poen_rgrm Ouecjpueing_Grghs_Waes_Adaqos _focow e

ML B o BEMLT 20 F Apd W &% Y- AR Sha
CRCETT
B"Lﬂ_ Correlations
) e
) Noses [DataSetl] D:\ASSESS\DataAP.sav
| L) Actve Datasst
B ol e
8 31d erors v V2 Vi Ve Vs ) V7
gn [ Powchorie | Polchonc | Polytheeks | Potnofc | Polyseeial | Polpchor:
& s;g:;"‘”"" 2 Petyehorit Polhoric | Pottherit | Poschone | Poserisl | Potethoric
) Te 3l Potychone | Poicharie Potythoere | Posychoric | Polyseeial | Patschonc
@) romes Ll Potytnont | Pokchoric | Pokehoric Poythone | Polsseisl | Polythone
1) Actve Dataset 5 Patyenonie | Podchone | Polshonc | Potrrhoek Poleseist | Pabechonc
D LL:; RGraphic [ Potysenal Pokysariat Polysenal Potysenal Poyseral Potysenal
7 Potyenonie | Poxchonc | Pokehone Potythaek | Poscnone | Pokssnal
8 Potysenal | Possrisl | Polysenial | Potysenal | Poyserssl | Pearson Polyserial

Correlation matex

[E] X [0
304 s03
-04s 40
1 000
™ 1000
597 ™
-120
282 041
128 683

® X2
I' |PASW Statistcs Processor is teady |



With Custom Dialogs one can:

Create native looking Menus...

... both for PASW syntax, Python and R (with integration plug-ins)

Create custom PASW Statistics output tables from the R (or Python) analysis

Write back analysis results to PASW Statistics active Data sets
spssdictionary.SetDictionaryToSPSS (“Results”, vardict)
spssdata.SetDataToSPSS (“Results”, Data)

What’s next?

» Save and Distribute easy-to-install Custom Dialogs between PASW end users (see
spss.com/devcentral for User and SPSS contributed Custom dialogs)

(in windows 7, a double click in the *.spd file will install it, automatically, in PASW statistics)
» Convert R code into ‘Extension commands’ to use R with PASW-like syntax

Need more information”?

See SPSS publications (free download at spss.com/devcentral)

» PASW Statistics-R integration package (in R essentials)

» Programming and Data Management for PASW Statistivs18 .- ..l



http://www.spss.com/sites/dm-book/resources/PASW-Statistics-18-DM-Book.pdf

Questions?
cComments?

Coffee?

Thanks for your attention!
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